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CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please  read  the following Software License Agreement  before  using  this software package. Using this software indicates
that you have accepted its terms and conditions.

SOFTWARE  LICENSE AGREEMENT

This agreement is between Carlson Software and me.

I promise not to change the software and not to let anyone else use it without Carlson Software's written permission.

I promise not to copy the software except for backup. I will keep a record of all copies I make and upon request let Carlson
Software see it.

I promise to do my best to keep unpermitted copies from being made, and I will destroy any copies I no longer want.

I understand that this is a single user /single system license. If I want to use the software on a different system, except in
emergency,  I understand another agreement must be signed, and allowing my copy to be used by anyone else is a breach of
this agreement.

Carlson Software  assumes  no responsibility to anyone for any special, consequential, collateral or incidental damages in
connection with or arising from the use of this software.

I agree Carlson Software can make changes in the software without letting me know and without giving them to me.

I promise not to modify any copyright, or trademark notice in the software, and  agree to protect Carlson Software from and
reimburse Carlson Software for, any loss if I do such modification.

If I change the software without Carlson Software permission, I understand I lose all rights to make any claims against
Carlson Software. In any event, I understand I must make any claims I wish to make in writing within 90 days after I receive
the software.

I agree the most Carlson Software could ever owe me would be a full refund of whatever amount I paid for the software. I
understand: the laws of the State of Kentucky will govern the interpretation of our Agreement; it is our only agreement about
the software; and if part of this agreement turns out to be invalid, the rest will remain in full force.

Copyright 1996-1999 Carlson Software
All Rights Reserved



HydroStar by Carlson Software
Release 2.0  6 December 1999

Overview:
HydroStar is a software product developed by
Carlson Software for positioning of barge-
based pile driving.  It uses the Global Posi-
tioning System (GPS).

Enter the desired pile position, either by North-
ing and Easting, or Station and Offset from a
specified centerline, and HydroStar will guide
you to that position.

One GPS receiver is set up at a fixed point on
land and serves as the base station.  It broad-
casts corrections to the two GPS receivers
mounted on the barge.  The two receivers on
the barge are attached by serial cable to the

computer running HydroStar.  HydroStar uses the centimeter-accurate positions from the two receivers
to determine the exact position of the pile driving equipment.

HydroStar can be set to work in any State Plane Zone, both SP27 and SP83.  UTM coordinates can also
be selected to work anywhere in the world.  You can choose whether to work in either English or Metric
units.

Currently HydroStar
works with the following
brands of GPS: Ashtech,
Leica (MC1000), Novatel
& Javad.

A depth sounder can be
added to the system to en-
able HydroStar to collect
data for mapping of under-
water terrain.



Creating the Vehicle File:

The image of the barge used in HydroStar is provided by the vehicle file.  This is a polyline file and has
an extension .veh.  It is stored in the directory C:\data.  The steps outlined here will guide you through
creating the vehicle file.  Alternately, you can contact Carlson Software (617-254-5429), provide us
measured drawings of your barge and we will create the vehicle file and send it to you, free of charge.

The drawing should be created in Carlson Software’s SurvCADD or another CAD package that allows
saving polyline files.  The barge should be drawn in the same units (feet or meters) you will be using in
your project.

There are three critical points on the barge: the two GPS antennas and the pile driver (or depth sounder).
The barge must be drawn correctly in order to appear correctly in HydroStar.  The barge should be
drawn so that GPS Antenna #1 is positioned at the origin (0,0).  The barge should be rotated until GPS
Antenna #2 is on the x-axis (y = 0).  We recommend drawing the outline of the barge and each GPS
antenna.  Any other structures on the barge can be drawn as you see fit.  Do not draw the four arrows
around the pile driver.  These will be added automatically as a check.

Export this drawing as a polyline file called barge.  It will have a .pnl extention.  Change the name from
barge.pln to barge.veh.  Put this vehicle file in the C:\Data or D:\Data directory.

Top Row:  Examples of barge layouts showing GPS1, GPS2 and Pile Driver.
Bottom Row:  These barges as drawn in the vehicle file with proper orientation.



Two critical measurements must be taken.  These will allow HydroStar to determine the position of the
pile driver from the position of the two GPS antennas.  The first is the angle between the line connect-
ing GPS1 to GPS2 (the x-axis in the drawing) and the line from GPS1 to the pile driver.  An angle of
zero would mean the pile driver is in line with GPS2.  The angle is measured counter-clockwise.  The
angle should be expressed in radians. (3.14159 radians = 180 degrees) (To convert from degrees to
radians, multiply by 0.017453)

The second measurement is the distance from GPS1 to the center of the pile placed by the pile driver.
This measurement should be in the same units your project is in.

These two measurements should be set in the menu Options>Options>Navigation Options.

When the barge is displayed in HydroStar, it will have a set of four arrows added to it.  These arrows
indicate where HydroStar considers the pile driver (or depth sounder) to be.  If their position relative to
the barge is not correct, there is a problem.  Either the barge is drawn incorrectly, or the angle and
distance specified under Navigation Options is incorrect.

Pile Driver Position Measurements



All of the settings controlling HydroStar are found in menus under the main
Options menu.  Click on the Options button on the main screen and then click
on the next Options button to find these menus.

Hydr oStar  Appearance
Reverse Video - In the usual color scheme (No), the graphics appear in light
colors on a black background.  Set this to Yes if you prefer dark colors on a
white background.
Full Keyboard - With this set to Yes, a full keyboard will appear on screen
each time you are asked to input something.  Set it to No if you prefer a partial
keyboard.
Use Colors in Plan View - If your monitor is color, this should be set to Yes.
Vehicle File - The filename of your vehicle file (barge.veh) should appear here.
If it doesn’t, click on this button.  You will see a button for each vehicle file that
exists in your Data directory.  Click on the barge.veh button.

General Options
Rod Height - This value is the vertical distance from GPS Antenna 1 to the water surface.  It’s very
important that this is set correctly if you are collecting points with the depth sounder.  Like all measure-
ments, use the same units you are working in.
Coordinate File - All points are stored in the coordinate file.  Click on this button to change the current
file or create a new one.  The coordinate file is stored in the Data directory.
RMS Tolerance - RMS is a measurement of the accuracy of the position being reported by the GPS
receivers.  HydroStar will warn you if you try to collect points when the RMS is higher than this limit.
That means the position isn’t accurate enough.  Default value: 1.
GPS COM Port - GPS Receiver One is attached to the computer using a serial cable plugged into this
nine-pin COM port.
PCMCIA Drive  - If files are to be transfered using a PCMCIA card, this is the location of the PCMCIA
slot.  If you will not be using one, do not worry about this setting.  (HydroStar was originally designed
for touch-screen computers without disk drives.)
Use Second GPS - This should be set to Yes since HydroStar needs position information from both
receivers to determine the orientation of the barge and the location of the pile driver or depth sounder.
Second GPS COM Port - GPS Receiver Two is attached to the computer at this COM port.
Use Depth Sounder - If this is set to Yes, HydroStar will read the depth sounder each time you collect
a point to find the elevation of the underwater terrain.
Depth Sounder COM Port - The COM port on the computer where the depth sounder is attached.

Options



Alignment Options
Zone - The State Plane Zone or UTM.  If this is set incorrectly, click on it.  You
will be asked if you are using UTM, SP27 or SP83.  Then you will be asked, if
applicable, which state and which zone of that state.
Unit Mode - Here you tell HydroStar whether you are working in feet or meters.
Transformation  - This is set to Plane Similarity or Rigid Body - No Scale.
The transformation aligns the local coordinate system using multiple align-
ment points.  Both methods use a best-fit least squares transformation.  Both
do a translation and rotation.  The difference is only Plane Similarity scales the
coordinate system to fit the alignment points.  Plane Similarity is the default.
One Pt Align Azimuth - The two settings are Geodetic and Grid.  This setting
only applies if you align using only one alignment point.  HydroStar will trans-
late the State Plane coordinates to local coordinates.  No scaling is done.  If you
choose Geodetic (the default), your local coordinates will be rotated using true
north.  If you choose grid, the local coordinates use State Plane north.
Auto Load Last Alignment - With this set to Yes, HydroStar will always use
the last alignment points.  This saves you the trouble of re-aligning every day,
but your base must be set up the same each time.  See the alignment section.
Project Scale Factor - This is to compensate for differences between distances
measured along the earth’s surface and distances on the State Plane grid.  All distances will have this
factor applied to them.  The factor is defaulted to one.  It is always close to one (starting 0.99 or 1.00).
This can be entered manually or read from the GPS receiver.

Navigation Options
Mode - Set this to Stake Pile Position to have HydroStar report distances and such based on the posi-
tion of the pile driver or depth sounder.  Set it to Stake Receiver Position if you want to have the
positions of the GPS Antennas reported to you instead.
Angle, GPS2 to Pile - This angle, measured in radians has GPS1 as its apex.  See Pile Driver Position
Measurements (page 3).
Distance, GPS1 to Pile - See Pile Driver Position Measurements (page 3).
Stakeout Tolerance - If the distance between your stakeout goal and your actual position is within this
limit, HydroStar will accept this point as successfully staked out.  In Navigate mode, the target starts to
spin when you are within tolerance.



Setup GPS

This screen is located under Options from the main menu. The GPS Setup allows you
to select the GPS receiver type or Manual mode. In Manual mode, HydroStar runs in
a simulation mode where the position and orientation of the bareg are controlled by
with the keyboard.

The Send Command to Receiver  routine allows you to send a command to the GPS
receiver. If you need to set or read a feature on the GPS receiver that is not in the
GradeStar Setup command, then you can use this routine to send the command. Any
response from the receiver will be displayed. Please refer to the GPS receiver docu-
mentation for descriptions of these additional receiver commands.

Simulation Mode

To run HydroStar without being hooked up to a GPS receiver, go to Options>GPS Setup and set the equipment
type to Manual. Go into Navigate.  You will see the barge displayed.  It will be positioned so that GPS 1 is at
point 5000, 5000 and GPS 2 is directly east.

Use the arrow keys to move the barge: up arrow = north, down arrow = south, right arrow = east, left arrow =
west.  The ‘R’ and ‘L’ keys will rotate the barge clockwise and counterclockwise, respectively.  You can simulate
moving the barge to a stake point and see the target spin when you get within tolerance.



The Align function is located under the Options button from the main menu.

HydroStar reads a LAT/LONG position from the GPS1 receiver which is converted to
a state plane or UTM x,y,z coordinate. Using local coordinate points and their corre-
sponding GPS position, Align Local Coordinates applies a transformation to convert
the state plane coordinate to the local. HydroStar can operate in three different modes
depending on the Align Local Coordinate settings:

- No alignment
- One point alignment
- Two or more point alignment

Without Align Local Coordinates set, HydroStar will operate with no alignment and
use the state plane coordinates directly. In order for the coordinates to be the true state
plane coordinates in this alignment mode, the GPS base receiver must be set up over a
known point and the true Lat/Long for the point must be entered in the base as the base
position. Otherwise, if the base is set over an arbitrary point, then the coordinates will
not be true state plane.

In one point alignment mode, one pair of GPS and local coordinates is specified in Align Local Coordinates. The
differences between the GPS and local northing, easting and elevation for these points are used as the translation
distances in the transformation. The rotation will use either the state plane grid or the geodetic as north. The
rotation type is specified in the Options command. No scale is applied in this transformation.

One point alignment is useful for data collection on a new site. In this case you can set the GPS base receiver up
anywhere convenient. Then position the rover (GPS 1) over the first point and run Align Local Coordinates. Add
this one alignment point by reading the GPS point and entering a local coordinate like 5000,5000,100. Now the
local coordinate system is set around this first point at 5000,5000,100.

Two or more point alignment is used to align to an existing local coordinate system. At least two pairs of local
and GPS coordinates must be entered. Two pairs of points is sufficient to define the translation, rotation and
scale for the transformation. If more than two points are entered, the program will find a least squares best fit
transformation.

For entering the local coordinate, you can either enter the northing, easting and elevation or specify a point
number which refers to the coordinate file entered under General Options. To enter the GPS position that matches
this local coordinate, you can either set up the rover over the local point and read the GPS receiver or enter the
GPS LAT/LONG for that point. In order to use the LAT/LONG, you must set up the base over a known point and
enter the correct LAT/LONG at the base. Reading the position from the GPS receiver does not have this restric-
tion which allows you to set up the base at any point.

Since known alignment points are hard to come by on the water, we suggest you take HydroStar and GPS 1 to
land and set up over fixed points to do the alignment.  The alignment only needs to be done once as long as the
base doesn’t change its position or output.

Align



Align displays a list of the points used for the alignment. To Add a new alignment point, type 1. To remove a
point, highlight the point using the arrow keys and then enter 2. The View option switches between showing the
local coordinates and the corresponding GPS LAT/LONG coordinates. The On option allows you to switch
whether the highlighted point is used for the horizontal and/or vertical alignment. The H column represents
horizontal and the V column vertical.  For example, you may wish to use 2 points for horizontal alignment and
one for vertical. In a multi-point alignment, if you don’t know if the elevation is good, turn the “V” column to N.
Otherwise you may “tilt” the ground surface.

In the local points view, the HRes column shows the horizontal residual and the VRes column shows the vertical
residual. The residual is the difference between the actual point and the point calculated using the alignment
transformation. Hres and Vres are displayed when there are three or more alignment points. In GPS points view,
the HRMS and VRMS columns show the horizontal and vertical RMS values when that point was recorded.

Northing     Easting     Elev     HRes VRes HV
5000.00       5000.00     993.50   0.0     0.0     YY
5324.52       4739.43     970.23   0.0     0.0     YY

1-Add 2-Del 3-View 4-On 5-Load X-eXit

LAT             LON          Elev     HRMS VRMS HV
41.153943 83.031243  992.87  0.03   0.04    YY
41.150232 83.034811  970.42  0.03   0.03    YY

1-Add 2-Del 3-View 4-On 5-Load X-eXit

To start a new local coordinate system, enter one pair of local and GPS coordinates. HydroStar will then do a
translation but not a rotation or scale. North for the GPS coordinates will be the same north for the local coordi-
nates.

In addition to the northing and easting transformation, GradeStar will also translate the elevation from the GPS
system to the local. The elevation difference between the two systems is modeled by a best-fit plane.

When HydroStar starts, there is no alignment data unless the Auto-Load Last Alignment option is set in the
Options command. If no alignment is loaded, the system is in state plane or UTM coordinates. To recall a
previously entered alignment, use the Load option in the Align Local coordinates command.

Load alignment is only valid if the base receiver setup has not changed since the alignment points were re-
corded. In order to use an alignment when returning to a site, you must set up the base receiver in the same
position and recall or enter the same LAT/LONG coordinates for the base.



Monitor

The monitor function is used to review the information coming in from the
GPS receivers and the depth sounder.  This information can let you know if
everything is working properly.  You will find the Monitor button on the main
screen.  Different brands of GPS receivers report different information, so there
are slight differences in the Monitor screens for the different equipment.  A
sample screen appears below.

LAT: 41.15325718
LON: -83.03497385
Northing: 5034.344
Easting: 5143.231
Elev: 993.50
LOCK (Solution Status)
Rover: ONE
COM Port: 1

LAT/LONG: This is the latitude and longitude of the position shown in degrees, minutes, seconds and decimal
seconds as dd.mmssssss. For example, -83.03497385 is 83 degrees, 3 minutes and 49.7385 seconds.  The nega-
tive means it is a longitude west.  A negative latitude is one in the southern hemisphere.

NORTH/EAST/ELEV: These are the local coordinates if a local alignment is defined. Otherwise these are the
state plane coordinates.

The Solution Status is one of the following:
Too Few Satellites: The GPS receiver is tracking less than five satellites which is not enough to calculate
position. To fix this, try moving to a position that has a better view of the sky.
Autonomous: The GPS receiver is in non-differential mode which means that it is not receiving base correc-
tions. In this mode, the position can vary up to 100 feet. The reason for this can be that the base is not broadcast-
ing, radio interference or weak radio signal from being too far from the base.
Float: The GPS receiver is in differential-code mode which means that it is trying to solve the exact position. In
this mode, the position can vary up to 10 feet.
Lock:  The GPS receiver is in phase-differential mode which has the solved, accurate position. This is the mode
to operate in.
Rover ONE, COM Port 1: The information shown corresponds to this rover, attached to your computer at this
COM Port.



Project
This screen sets the data files to use in the Navigate function. To set a data file, pick
on the button for that file. Then a list of the available files is displayed. Pick on the
button for a file name to set the data file to this name. To set a data file to NONE,
choose the BACK button. To create a new file, choose the ENTER NAME button and
type in the new name.

Load Design Grid File - This can be left with nothing selected.

Load Actual Grid File  - This can be left with nothing selected.

Load Plan View File - This is the drawing showing the plan view of the site.  It is used only as a
visual aid for you.  HydroStar does not take any information from it and does not modify it.  The
drawing must be a polyline file with a .pln extension.  It needs to be in the data directory.

Load Centerline File - The centerline file must be specified if you plan to stake to stations and
offsets.  This file needs to be created using Carlson Software’s SurvCADD or Carlson Survey.  It has
a .cl extension and is stored in the Data directory.  The centerline can include curves and spirals.



Navigate
The most useful function of HydrStar is Navigate.  This routine is used to
stake out points.

Click on the Navigate button from the main menu.  You will be asked what
method you would like to use for staking out the points.  The choices are:
Enter Coordinates; By Point Number; and By Station and Offset.  If you
know the coordinates of your destination point, pick this option and enter the
Northing, Easting and Elevation when prompted.  If the point you want
already exists in your coordinate file, pick By Point Number and enter the
point number of this point.  To do By Station and Offset, you must have a centerline file in the
C:\Data directory and specified in the Project menu.  You will be prompted for what station and what
offset you want staked.

Once HydroStar knows what point you are staking out, the plan view showing your barge appears on
screen.  The stakeout point shows up as a circular target.  If you don’t see the target, it is off the
screen.  Hit the Zoom Out button until you can see it.



The Navigate screen appears on the preceding page.  Our Mode under Navigation Options is set to
Stake Pile Position.  HydroStar is leading us to the point where our pile driver is at the target point.
The four arrows are added to the barge drawing by HydroStar.  They show where the pile driver is.

If your Navigate screen looks different, HydroStar is set to Stake Receiver Position and HydroStar is
guiding you to where your GPS antennas are at the target locations.

The first item, Stake Point, shows the Northing and Easting of the target point you set.  Below that
HydroStar shows you the current Pile Driver Position in Northing and Easting.  Following that is the
distance you must go to arrive at the stake point.  Following this are the directions to arrive at the
target.  Here we need to move 61.23 meters south and 37.61 meters west to get the pile driver to the
target location.  (If our Unit Mode under Alignment Options was set to feet, all of these
measurements would be in feet.)

Status refers to the accuracy of the position being reported by the GPS receivers.  The status should
be LOCK.  This means the receiver is locked on to the base’s corrections and is calculating an
accurate position.  If the status is FLOAT, the reciever is picking up some information from the base,
but is not fully sure of its true position.  If the status is AUTONOMOUS, the reciever is not picking
up anything from the base.  There could be a problem with the base or a radio problem.

There are five buttons at the bottom of the screen.  Zoom In and Zoom Out change the section
visible.

If you have arrived at the target point, the target should be spinning.  If you are happy with your
location, you can hit the Accept button to record this point for future reference.  It will tell you
exactly how close you are.  You will then be prompted for the next point you want to stake to.

HydroStar creates a text file as a record of points you have staked out.  This file includes information
on which stake mode you were using, your target point coordinates, the coordinates of the point as
actually staked, the distance between these points, a time and date stamp,and whether the GPS
receivers were Locked.  You can find the file in the \Data directory.  It’s called stake.txt.  It’s
formatted as comma delimited text, so it’s easy to import to Microsoft Excel or any other
spreadsheet.

The Monitor button brings you to the Monitor screen.  You can inspect the information coming in
from the recievers.

The Exit button takes you back to the main menu.



Transfer

The Transfer routine is used to transfer data files to the HydroStar computer. These
were designed for touch-screen computers lacking disk drives.  There are two func-
tions under Transfer:

PCMCIA Card to HydroStar
HydroStar to PCMCIA Card

The routines apply to computers that have a PCMCIA drive. The drive letter for the
PCMCIA drive on the computer should be specified under the Options menu. The
program will display a list of the available files to transfer. To transfer the file, simply pick on the file name.

Exit

To exit HydroStar, clixk on the Exit button from the main menu.  You will
be asked if you really want to exit.  Pick Yes.



Plot

The function Plot lets you look at the points you have in your coordinate file.
These can be points you collected using the Collect function or the Accept
button in Navigate.  They can also be points imported from another Carlson
Software product.

There are two choices of how to see the points.  The first is List Points.  Tell it
what range of points you want to see, and HydroStar will show you the Point
Number, Northing, Easting, Elevation and Description for each point.  The other option is to Plot
Points.  This will bring up a plan view similar to Navigate.  At the bottom of the screen is a button
labeled “Plot”.  Click this button and tell HydroStar what range of points you want and these points will
be plotted on screen.

Collect

This function is used to gather points as part of a survey.  It reads the position
of the GPS antenna or depth sounder and stores it as a data point in the coordinate
file.  You can enter a description for the point.  The description is also stored in
the coordinate file.  The points stored are also displayed as “X”s on top of the
plan view drawing.

If you are using a depth sounder, the elevation of the point stored will be
calculated by subtracting the depth reported by the sounder from the GPS elevation.  The Rod Height
setting in General Options should show the height difference between the GPS1 antenna and the zero
point for the depth sounder.  The rod height will also be subtracted from the elevation.  If you are in
Stake to Pile mode, the program calculates the horizontal position of the point in the same way it does
for the pile in Navigate.  Therefore you should set the two numbers that determine the pile driver
location (Angle and Distance under Navigation Options) so they refer to the location of the depth
sounder instead.  If this is too much trouble and you want to store points while pile driving, you should
place the depth sounder as close as possible to the pile driver.  The points will reflect the horizontal
position of the pile, but the bottom elevation at the depth sounder location.

There are three ways to collect data: manually, automatic by distance and automatic by time.  If you
select manual mode, you will have a button to push each time you want to store your currently occupied
point.

Automatic by distance mode will prompt you for what distance to use.  If you input 20, HydroStar will
store a point each time the GPS antenna has moved twenty feet.  Automatic by time lets you input the
time interval (in seconds) you want between readings.  Either of these modes can be used to plot the
route the barge travels.



Appendix B - File Formats

Plan View (.pln) and Vehicle (.veh) Files:
Both Plan View and Vehicle files use the same file format. This format defines a series of

polylines which are lines with two or more points. Each polyline begins with a line of “POLYLINE,Color
number”. Then the points for the polyline are listed on separate lines in X,Y,Z format. If no color is
specified, the color white is used by default. Here is a list of the available color numbers:

0 Black 8 Dark Gray
1 Blue 9 Light Blue
2 Green 10 Light Green
3 Cyan 11 Light Cyan
4 Red 12 Light Red
5 Magenta 13 Light Magenta
6 Brown 14 Yellow
7 Light Gray 15 White

Plan View Example:
POLYLINE,15
47639.82,74540.11,0.00
47670.49,74565.79,0.00
47701.08,74591.49,0.00
49375.61,76358.47,0.00
50066.86,76846.75,0.00
POLYLINE,15
47633.24,74547.97,0.00
47663.90,74573.65,0.00

etc...

Appendix A - HydroStar Files

C:\HYDRO\HYDRO.EXE - the main HydroStar program
C:\HYDRO\HYDRO.INI - user settings
C:\HYDRO\SP83.GPS - data tables required for state plane 83
C:\HYDRO\SP27.GPS - data tables required for state plane 83
C:\HYDRO\CGA.BGI - needed for graphics
C:\HYDRO\EGAVGA.BGI - needed for graphics
C:\HYDRO\SANS.FNT - text font file
C:\HYDRO\*.BGP - icon files
C:\HYDRO\*.FNT - font files
C:\HYDRO\METWND05.DRP - program file
C:\HYDRO\SP*.TXT - state names for state plane zones
C:\HYDRO\UTM.TXT - UTM zone names
C:\DATA\*.VEH - vehicle outline files
C:\DATA\*.PLN - plan view files
C:\DATA\*.CL - centerline files


